Online Backup Client User Manual Windows 5.0
1. Product Information
Product: Online Backup Client
Version: 5.0.2
1.1 System Requirements
 Windows XP (Unofficial, no support)

Operating System



Windows Vista, Windows 7, Windows 8

 Windows Server 2003 / 2008 / 2008 R2 / 2012
 PC with 1 Gigahertz (GHz) or higher processor clock speed

recommended
Hardware Resources



1 GB memory

 25 MB of disk space
 Internet connection (e.g. ADSL, SDSL)

Required software



Microsoft .Net Framework 4.0

Note: A separate manual is available for the Online Backup Client for Linux and Mac OS X.
Note: A separate version, 4.3.1 is available for Windows 2003, which runs on .Net Framework 2.0.
There are two types of account licenses: Workstation and Server. The difference between features
and Operating Systems are:
Workstation (F.K.A. Home) License: A user can backup and restore file data and System State.
Server (F.K.A. Professional) License: A user can backup and restore file data, System State, MS Exchange
and MS SQL Server, as well as creating a mapped network drive in the client.

Operating System

Workstation

Server

Windows XP, all editions, 32bit + 64 bit

X

X

Windows Vista, all editions, 32bit + 64 bit

X

X

Windows 7, all editions, 32bit + 64 bit

X

X

Windows 8, all editions, 32bit + 64 bit

X

X

Windows Server 2003, all editions, 32bit + 64 bit

X

Windows Server 2008, all editions, 32bit + 64 bit

X
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Windows Server 2008 R2, all editions, 64 bit

X

Windows Server 2012, all editions, 64 bit

X

Client 4.3.4 is officially compatible with Windows 7 and Windows 8.

2. Features
2.1 Application plug-ins
The Online Backup Client makes it very easy to backup Microsoft Outlook and Windows System State,
containing e.g. Windows Registry, Active Directory, System and Boot Files.

2.2 Scheduled backup
You can make one or more scheduled backup tasks. You can schedule the tasks multiple times a day,
weekly or monthly. After the tasks are created, they will run through their schedule automatically. After
completion of a backup, a report is sent by e-mail. You are always up-to-date on the status of your
backups.
2.3 Management Console
The Online Backup Service also includes a Management Console, which can be accessed through an
internet browser (e.g. Internet Explorer or Firefox). It has several functions:





Access your data to restore or remove a file 



Change user settings (e.g. password) 



Overview of your backups through logs and reports 
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3. Setup
3.1 Setup Wizard
After executing the setup you can choose your preferred language for the Setup Wizard. Currently
English (United States), English (United Kingdom), Dutch, French, Spanish, German, Italian, Polish,
Danish, Norwegian, Hungarian, Portuguese, Portuguese (Brazil), Romanian, Japanese, Vietnamese,
Turkish and Russian are supported.

The next steps are:






Accepting the license agreement 



Choosing an installation directory 



Choosing a Start Menu folder name 



Selecting preferred shortcuts 
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If the .Net Framework (4.0) is not yet installed on your computer, you can retrieve this freely from
the Microsoft download site.
When the completion screen shows, the Online Backup Client is successfully installed on your computer!

3.2 Registration Wizard
When the Online Backup Client is started for the first time, it will start with the Registration Wizard.
The Registration Wizard guides you to fill in the account information and encryption key. With the
encryption key your data will be encrypted and decrypted.
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First, you need to fill in the username and password that you have created or obtained from your Online
Backup Provider.
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Note: This screen also displays the computer name which will be registered at the Backup Server to
store all files.
Note: If you don’t remember your password you can click on the link below the password text field.
A reminder will then be sent to your registered e-mail address.
Note: If there is a problem with the username and password, several causes can apply to this:





The username and/or password does not exist or is incorrect 



The time on your machine differs very much from the real time (more than 24 hours) 



Required port 443 (SSL) is blocked by an anti-virus program or firewall on the network 

The next wizard page will ask you to set an encryption key. This key encrypts all backup data and
decrypts data when restoring.
You can set the encryption key only once. After setting this key it cannot be changed. If you forget the
encryption key, it is impossible to access your backup data. Please keep a copy of the encryption key in a
safe place.

IMPORTANT: This key is unique and can only be chosen once and cannot be changed afterwards. Treat
this key with great care, since it is required to restore your files after a system crash.
Note: It is possible to store a reminder which can be sent to your personal e-mail address. In this wizard
the field to enter the reminder will change into a link: ‘Forgot your encryption key?’
The wizard is now finished.
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4. The client interface
The main interface of the Online Backup Client, shown in the figure on the right, consists of
3 components:
1. Navigation Panel
2. Account Information
3. Main Panel (e.g. Home)
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Navigation panel
The Navigation Panel is the main navigation through the Online Backup Client. The options:








Home: Monitor the status and use Wizards 



Backup: Create and manage backup tasks 



Restore: Restore your remote backup data 



Reports and Logs: View status information of executed backups 



Options: Configure program settings 



Support: View contact information for support 



About: Additional information about the Online Backup Client



Account Information 


Shows account details, such as: 







Account Name 



Amount of Remote Storage 



Program Status 



Usage of your Remote Storage 

Main Panel
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The Main Panel is the working space of the Online Backup Client. This panel will change its view, while
navigating through the Online Backup Client.

5. Home view
Overall status
When starting the Online Backup Client, the program will show the Home view. This view can also be
accessed through the Navigation Panel. On top of the Home view you can see the overall status of the
backup service.

Task statuses
At the bottom of the Home view the latest five backups are shown. Next to the task names you can see
the status and the date/time they finished.
Below the table the next scheduled backup task is shown including the start date and time.
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6. Backup
6.1 Manage backup tasks
By clicking on ‘Backup’ in the Navigation Panel, you can manage your backup tasks. By selecting a task
in the task list, you can examine its specifications. You can manually run, edit or delete the task. It is
also possible to create new tasks.

6.2 Creating a backup task
10

To create a backup task, click on ‘New task’ below the task list in the Backup view. ‘Task Properties’ will
pop up; it allows you to configure the task. If you cancel Task Properties, the task will not be saved.
Read more about how to configure a task with Task Properties in paragraph 8.3.
6.3 Task Properties
Task Properties appears when creating a new task, or editing an existing task. It allows you to
configure the settings of the task. Task Properties contains 5 tabs:








General: Task Name, Description and Backup Type 



Data: Select data resources for backup 



Schedule: Time and Frequency, Retention 



Filter: Exclude files and folders from backup 



Advanced: Volume Shadow Copy, Pre- and Post-Scripts 

6.3.1 General tab
The ‘General’ tab allows you to set the general options of the backup task.
Name and Description
It is advised to give the backup task a descriptive name to increase the recognition of the task when
monitoring. Optionally you can enter a task description.
Active
When checked, the task is activated and will be performed by schedule.
Shutdown Computer when completed
When checked, your system will shut down automatically after completion of the backup task. This
option has been disabled on servers. Also, the client has to be running for this option to be effective. If
the client is closed the computer will not shutdown, to prevent unexpected shutdowns. In case a
shutdown is desired even if the client is not running, you can add the following post script in the backup
task: Shutdown -s -t 600
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Backup Type
By default, the Online Backup Client makes backups online (to an external Backup Server, over the
Internet). It is also possible to make a local backup, e.g. to a removable hard disk. This results in a selfextractable ZIP file which can be shipped to your Online Backup Provider. The Online Backup Provider
can include the data in your backup account.
By selecting the ‘Offline backup (local backup)’ radio button, a default local backup directory is displayed
in the ‘Location’ textbox. It is possible to change this location by browsing to an additional directory.
When you enable Compression, the result will be put in a zip archive. This can take a while to complete.
If you leave this option disabled, compression on the individual files will still be applied. An offline
backup will always be a full backup.
Set Retention
Retention allows you to set the number of days your backup data will be kept before it is removed. Data
will be removed after set number of days in the following situations:







If an existing full backup is replaced by a new full backup 
Example: A full backup takes place when data is backed up for the first time, or when the
difference in data is more than 66%. If a new full backup is made, the old full backup will
be automatically removed after the set number of days. 



If the data is no longer located at the original location 
Example: If you made a backup of certain folder and you remove, rename or replace that folder
on your computer, the backup of the folder will be deleted after set number of days. 
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You can also choose to not remove the selected backup data, in which case all backups of the data will
be kept.
Note: When the task is set as an offline backup type (local backup), the option to set retention will
be grayed out.
Note: The retention value is changed for all files in the task, no matter whether they still exist on the
user’s computer or not.

6.3.2 Data tab
The ‘Data’ tab allows you to select data to backup within the task. You can easily navigate through your
system with the Windows Explorer-like tree at the left. Data can be selected by checking the boxes in
front of the files and folders.
When a folder is selected for backup, underlying files and folders are automatically included in the
selection, unless explicitly deselected.

Note: If a folder is checked with a grey background only a subset of this folder is part of the backup set.
Note: A light grey square in front of a file or folder means that it is not possible adopt that item in the
backup set
Map network drives
You can map additional network drives, by clicking on ‘Network Drives’. A drive letter will be added to
the data tree, which can be selected for backup.
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6.3.3 Schedule
You can set a schedule for the backup task in the ‘Schedule’ tab. A task can be scheduled by setting a
start time and frequency.
By default, the schedule is set to a daily backup at the time the task originally is created.

The following frequencies can be set:







Once: Task is performed once 



Daily: Task is performed daily 



Weekly: Task is performed one or multiple days a week 



Monthly: Task is performed once a month 

6.3.5 Filter
The ‘Filter’ tab offers the possibility to exclude files and folders from the backup set. You can also
choose to include hidden files by checking the checkbox.
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Filter options:






No file filtering 



Filter out files on file name/extension (‘Except specific files and folders’) - (default) 



Filter out all files except with certain file name/extension (‘Exclude all but specific files’) 



Filter out folders by path pattern (e.g. Temp, Cookies, etc). 

Note: To specify a filter, regular search expressions can be inserted:






Filter document (.docx) files: *.docx 



Filter files starting with hello: hello* 



Filter a specific file: ntuser.dat 

6.3.6 Advanced tab
Pre-Script
A Pre-Script is an advanced option to run certain operations before starting the backup task. You can
simply browse a command or batch file (e.g. C:\scripts\command.bat) which will be executed prior to
the start of the backup task.
Continue if Pre-Script fails
When checked, the backup will be performed, even if the pre-script did not run properly.
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Post-Script
A Post-Script is an advanced option to run certain operations after a backup task has run. You can simply
browse a command or batch file (e.g. C:\scripts\command.bat) which will be executed after the backup
task is completed.
Note: The options for Exchange are explained in paragraph 15.2

Enable Volume Shadow Copy
When checked, the task will backup files that are in use (open files).

6.4 Monitor backup progress
The backup process can be monitored by clicking on the magnifier glass in the backup progress box left
bottom of the client. This box is only shown during a backup process.
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6.4.1 Details screen
Progress bars




File progress: The progress of the backup of the indicated file 



Total progress: The progress of the total backup task 

Details table (shown on click ‘Details>>‘)









Full: Full backed up files 



Patch: Patched backed up files (incremental backup patch over last backup) 



NoNeed: Unchanged files (unchanged compared to last backup) 



Skipped: Skipped files (details in the logs) 



Done: The total amount of processed data 



Total: The total amount of selected data 



%Done: The percentage of processed data 

Other information








Avg.upl.speed: The average upload speed 



Remaining time: The estimated remaining time 



Elapsed time: The elapsed time 



Compression: The average compression rate of the backed up data 



Size uploaded: The size of the uploaded data 



Total size: The total size of the selected data 
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7. Restore
7.1 View stored data
Your remotely stored data can be accessed by clicking ‘Restore’ in the Navigation Panel. The
‘Restore’ view allows you to restore this remote data to your computer.
The Windows Explorer-like view shows one or more computers, because the data is related to the
source computer. When you open a computer node, you will notice that all data kept the same
structure as it was on your computer.

7.2 Restore data
Data can be restored per file, folder or drive. Select files, folders or drives you want to restore in the
Restore view. By clicking on the ‘Restore’ button, the ‘Restore Options’ screen will pop up and allows
you to select a version and a restore location. Read paragraph 9.3 for more information.
7.2.1 Restore local backup
Within the Restore view it is possible to import your local backups. This allows you to restore data from
e.g. a local hard disk to your computer. This data can be created by yourself (local backup), or delivered
by your Online Backup Provider, for fast restoring purposes.
Select ‘Import local backup’ in the Restore view, and choose for ‘archive’ if the data was compressed
into a ZIP file or choose ‘folder’ if the data was uncompressed (besides the standard compression that
takes place). Keep in mind that you need to select the root folder of the folder structure you want to
restore. Once the local backup is loaded in the tree of the Restore view, you can restore the data in
the same way as your remote data.
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7.2.2 Alter Retention
Within the Restore view it is also possible to alter the retention per file, per folder or per computer.
Note that altering retention will count for all sub folders, files and versions within those folders.
7.3 Restore Options
7.3.1 Version
The client can store multiple versions of files. This gives you the opportunity to choose which of
these versions you want to restore.
Latest version
To restore the latest version, keep the version setting unchanged. This means that the ‘Latest version’
radio button is selected.
Restore at date
It is possible to restore a file or folder at a selected date in history. Select the ‘Older versions’ radio
button. Now you can select a date in history. The latest backed up versions of the selected files or
folder before that date will be restored (if that backup version exists).
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Restore specific version
A specific version of a stored file can be selected. To do so, select the ‘Specific version’ radio button.
The available versions of the file will be displayed in the dropdown box. Simply select the
favored version.
This option only works for individual files and not for folders.

7.3.2 Location
The location is where the files will be restored.
Default location
The Default location is predefined. The default location can be changed in the Options view (see
paragraph 11.7).
Original location
When ‘Original location’ is selected, the files will be restored to their original location on your computer.
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Selected location
If you want to browse a location, choose this option.
Duplicate Files
When duplicate files are detected on the chosen location, it will by default prompt to ask if you want to
overwrite, rename or skip the file(s). You can also change the setting so it will automatically perform one
of these options.
7.3.3 Calculate restore size
You can choose to calculate the restore size. Enabling this option allows the Online Backup Client to
give an estimation of the restore time remaining. Skipping this calculation saves time.
7.3.4 Apply Scripts
When clicking ‘Apply scripts’, a popup will show that allows you to use Pre- and Post-scripts. For more
information on these scripts, read the paragraphs ‘Pre-script’ and ‘Post-script’ in paragraph 8.3.5.
7.4 Deleting stored data
First select the data that needs to be deleted (you can select multiple files or folders). Click on ‘Delete’ in
the lower main panel to delete the file(s) or folder(s). You can also choose for a specific version of a file
to be deleted. Furthermore you can choose to keep the latest version of the selected data.

Note: When deleting a folder containing many files, the details windows will show the progress of the
deletion. It can take some time to delete all files.
7.5 Monitor restore process
The restore process can be monitored by clicking on the magnifier glass in the restore progress box on
the left bottom during the process of a restore.
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Progress information


















File progress: The progress of the restore of the indicated file 



Total progress: The total progress of the restore 



Files Restored: The number of files that have been restored 



Files Skipped: The number of files that have been skipped 



Bytes Restored (MB): The amount of restored files in Megabytes 



Bytes Skipped (MB): The amount of skipped files in Megabytes 



Bytes Received (MB): The amount of received files in Megabytes 



Download speed: The average download speed 



Remaining time: The estimated time remaining 



Elapsed time: The elapsed time 



Compression: The average compression rate of the backed up data 



Size downloaded: The size of the downloaded data 



Total size of restore: The total size of the selected data 

8. Reports and Logs
8.1 Reports
The “Reports”-view shows a history of reports. You can view the status of past backups and restores.
Details of a report can be viewed by selecting the report and clicking on ‘View’ or by double-clicking the
report. This report will also be sent to you by e-mail after a task is completed.
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8.2 Logs
The ‘Logs’ view shows a history of log files. Three types of events can occur:




Information 
This is information on the progress of the backup or restore procedure 



Warning 
Non fatal errors occurred during the backup or restore process. 



Error 
A fatal error has occurred in the Online Backup Client. 
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Details of a log message can be viewed by selecting the specific log message and clicking on ‘View’ or by
double-clicking on the log. This shows a dialog with detailed information of the message.
In some cases it is possible to get a more detailed view of the log file by clicking on ‘Details >>’.

8.3 Cleaning Reports and Logs
In a few steps it is possible to clean the reports or logs list. In the list of reports or logs, you can make a
selection (using ctrl and shift). To clear the list, click on ‘Delete Selection’.
You can also choose to send a notification report of this log to the provider. An e-mail will be send to
the provider containing this log file.
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9. Options
You can change program and process settings in the Options view, which can be accessed through
the ‘Options’ button in the Navigation Panel. The Options view contains the following tabs:








General 



Backup and Restore 



Advanced 



MS Exchange Server 



MS SQL Server 

9.1 General tab
In the General tab, you can set general options of the Online Backup Client. Self-explaining
checkboxes can be used to configure the program settings. Next to that you can set the language of
the Online Backup Client. You can also change your password of your backup account.
Note: It might not be possible to change your password in the Online Backup client, since your
Online Backup Provider can disable this option.
9.2 Backup and Restore tab
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In the Backup and Restore tab, you can set options that are specific for backing up and restoring
with the Online Backup Client.

Backup
Start backup of missed task
When this setting is enabled, the missed tasks will automatically start the next time the service of the
Online Backup Client is started.
Request confirmation when starting a missed task
When this option is enabled you get a pop up box where you can choose to start the missed backup
task(s).
Data Retention
The default setting is set to ‘Automatically remove backup data’ with a value of 30 days. You can change
the value of days or you can set data retention to ‘Never remove backup data’. The default setting will
apply for every new task which is created henceforward.
Restoring
The textbox contains the default restore location. This is the folder where data is restored by default
when you don’t choose a specified folder.
9.3 Advanced tab
Advanced
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Backup- and restore-privileges
This overrules access rights for administrators for backup purposes.
Add Backup/Restore reports to windows logs
Used to track errors in the backup or restore processes.
Enable the diagnostics
Diagnostics is a logging system for error tracking.

Temporary folder
You can select the folder where temporary files are stored before they are transferred to the Backup
Server.
Note: Make sure there is enough disk space available to store the largest file to upload.
Note: Make sure that this is an empty folder, because this folder is cleared after the backup.
Connection
Bandwidth usage
This allows you to adjust the upload speed in percentage (%) of the available bandwidth between
the Online Backup Client and the Backup Server.
You also have the option to only limit the bandwidth usage between office hours.
27

Compression Settings
You can add file extensions that should never be compressed during backup. You can add multiple
extensions separated with commas.
Minimum file size (bytes): Smaller files will not be compressed
Maximum file size (bytes): Larger files will not be compressed. (0 = no maximum file size)

10. Support
Clicking on “Support” in the "Navigation" panel will give contact details of your Online Backup Provider.

11. About
Clicking on “About” in the "Navigation" panel will give details on the version of the software and
the license of the software.
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12. Windows System State
12.1 System State backup
When creating or editing a backup task, you have the option to select and include System State as part
of your backup data. In the ‘Data’ tab, you will see the 'System State' in the combobox behind 'Make a
backup of'. After selecting System State, you can select the System State for backup. You will see an
overview of the sections of System State that will be included in the backup.
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Note: Make sure to disable Volume Shadow Copy at the ‘Advanced’ tab when creating the backup task
for System State.
12.2 System State restore
To restore System State, simply select it in the restore screen and click ‘Restore’.
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When the restore of System State is finished, you will be asked to restart in order to complete the
System State restore. If you choose ‘No’, the System State restore will be completed after the next time
you restart your machine.

13. Microsoft Exchange 2003/2007/2010/2013
13.1 Introduction
To support backup and restore of MS Exchange Server 2003, MS Exchange Server 2007, MS Exchange
Server 2010 or MS Exchange Server 2013, the Online Backup Client has to be installed on the same
machine as the server. The Online Backup Client supports Exchange backup in three ways:





Through an ESE plug-in for Exchange 2003 mail store backup. 



Through an VSS plug-in for Exchange 2007 (and newer versions) mail store backup 



Through the folder level backup option (enables backup of separate mailboxes). 
31

Note: ESE is the API of Exchange allowing backup applications to make a consistent and reliable backup.
Note: Folder Level backup is not available for Exchange 2010/2013.
13.2 Backup on mail store level (ESE & VSS plug-in)
To enable backup of mail stores, this option must be activated first. This can be done by checking
‘Activate Exchange backup’ in the ‘Exchange Server’ tab in the ‘Options’ view.

Now the plug-in is activated, complete Servers, Storage Groups and single Stores can be selected for
backup, in the Data tab in Task Properties.
Apart from the requirements listed below, performing a backup of an Exchange item is not
different from doing backups of regular files and does not involve any further user actions.

Note: ‘Circular logging’ on the Storage group must be disabled.
Note: A mail store that is requested to be backed up must be mounted in order to be accessed.
Dismounted Stores may appear in the folder-pane but cannot be backed up.
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For Exchange Store level backups, you can set advanced options in the ‘Advanced’ tab of the
backup task. The following options can be set:
Exchange Advanced Options


Truncate the transaction logs after a full backup: This means that the log files will be truncated
in the Exchange database when a full backup of the Exchange Store is enforced. 

Enforce Full Exchange store/SQL Backup





Let BackupAgent decide: This means that if more than 66% of the dataset changed compared
with the already backed up data, the client will enforce a full back up again. 



Always: This means the Online Backup Client will always enforces a full backup. 



Never: This means that there will never be a full back up again, other than the first backup.



13.2.1 Backup requirements 




MS Exchange Server must be installed and running on the local machine in order to perform
backups. 



The user that performs a backup must be assigned backup and restore privileges. 



Circular logging must be disabled. 




Note: The Online Backup Client performs full or incremental backups. However, since incremental
backups require a continuous series of log files, it is not possible to use third party software when
the Online Backup Client is used to schedule backups of Exchange. This also holds vice versa. Third
party software can cause data loss, since some programs remove logs.
13.3 Restore on mail store level
Backups of mail stores are listed in the ‘MS Exchange Server’ folder in the ‘Restore’ view. This folder
holds sub folders for every Exchange Server that has been backed up. The restore can be performed in
the same way as a normal data restore. Read chapter ‘Restore’ for more details on restoring from the
Restore view.
The complete restore procedure has been defined in a separate Whitepaper because this is a delegate
task. You can download it from our support site:
http://kb.acronis.com/backupagent-MS-Exchange-Server-backup-with-BackupAgent
13.4 Backup on folder level
The ‘folder level backup’ option is meant to backup separate mailboxes and its subfolders. This option
offers an alternative to a full backup of MS Exchange 2003 and enables you to perform small restores of
parts of the mail stores.
Note: Due to significant architectural difference between Exchange 2003 and Exchange 2007, there’s no
direct support for the Exchange 2007 folder level backup implemented in the Client in this release.
However it is now possible to perform the Exchange 2007 folder level backup from a remote computer,
if Exchange 2007 is installed onto a Windows 2003 Server 64 bit system. For more information, please
follow this link:
https://kb.acronis.com/content/53888
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To enable a folder level backup, the option ‘Activate Exchange server backup on folder level’ must
be checked. This checkbox can be found on the ‘Exchange Server’ tab in the Options view.

When folder level backup is activated a new ‘MS Exchange (folder level)’ node is added to the selection
tree of the Data tab in Task Properties. This node can be expanded and allows you to browse through
and select all mail stores, mailboxes and subfolders. Selected items will be added to the backup task.

Note: For ease of use and overview it is recommended to create a separate task for Exchange folder
level backup. Do not mix this data with files to prevent confusion.
You are now ready to backup Exchange mailboxes. A backup of mailboxes works similar to the backup of
files and folders. Next to that, Additional metadata concerning mailbox properties and settings are also
uploaded.
Note: Please make sure that the temp-folder of the Online Backup Client is set to a path with enough
available temporary disk space, since folder level backup can require a comprehensive amount.

13.4.1 Backup Requirements
Additional requirements





MS Exchange 2003 Service pack 2 must be installed 



Windows 2003 must be installed 



Hot fix KB53954 for Exchange 2003 must be installed: 

https://kb.acronis.com/content/53954
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Security settings




The ‘SystemMailbox’-user must not be hidden from the Exchange address list 



The local and/or domain administrator must have ‘receive as’ and ‘send as’ permission to the
mail store(s). 

How-to: Un-hide SystemMailbox-user
1. Start the Active Directory management application
2. On the parent node for all users, right-click and choose ‘Find users…’
3. In the ‘Find Users’-dialog, type ‘SystemMailbox’ in the ‘Name’ field and click ‘Find…’:
4. Select the user and open its properties

5. On the properties, click on the ‘Exchange Advanced’ tab
6. Make sure the ‘Hide from Exchange address list’ checkbox is unchecked
7. Click OK and close the application
8. (Re)start the Online Backup Client

How-to: Change permissions of the administrator
1. Start the MS Exchange System Manager
2. Browse to the mail store node in the tree
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3. Right-click on the node and choose properties
4. In the Properties dialog, click on the Security-tab
5. On the Security-tab, click on the Advanced-button

6. In the ‘permission entries’ list, select the local and/or domain administrator and click ‘Edit…’
7. In the Permission Entry dialog browse through the list of permissions
8. Check the ‘receive as’ checkbox permission in the ‘allow’ column
9. Check the ‘send as ‘ checkbox permission in the ‘allow’ column
10. Click Ok and close the application
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11. (Re)start the Online Backup Client

Note: If the Exchange Server is a Domain Controller, then the Domain Administrators must also have
permission for ‘Send As’ and ‘Receive As’.
13.5 Restore on folder level
Once mailboxes are backed up on the Backup Server, restoring is possible on any Exchange server. You
can browse for mailbox items in the ‘Restore’ view. To restore, simply select one or more items and
then click on ‘Restore’.
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Now, the Restore Options screen pops up. When you select ‘Original Location’ in the ‘Restore to MS
Exchange Server’ options, you will overwrite the current data in the folder in Exchange.
When choosing ‘Create copy of item’, an additional folder with a ‘Copy of’-prefix (i.e. ‘Copy of Inbox’)
will be created in the user’s mailbox.

Caution: Overwriting the items may cause data loss. It is strongly recommended to use this option only
in case the original mailbox is empty or contains old data.
Caution: If you restore in ‘Copy of item’ mode, be aware that this copy might be part of next backup if
the complete mailbox is selected for backup.
Note: For ease of use and overview it is recommended to create a separate task for Exchange folder
level backup. Do not mix this data with files to prevent confusion.
13.6 Backup of Exchange using VSS
Finally Online Backup Client supports VSS and this can force Exchange to write a consistent backup copy
of the .edb-file and the stm file to the shadow volume. Therefore selecting these files is a reliable way of
making a daily full backup, which will be patched as a file by Online Backup Client to upload only the
changes.
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14. Microsoft SQL Server 2005/2008/2012
14.1 Introduction
The Online Backup Client supports backup and restore of SQL Server 2005, 2008 and 2012. This
option can be activated by selecting 'Activate SQL Server Backup' in the ‘MS SQL Server’ tab in the
Options view.
If there is more than one instance of SQL Server installed onto the computer running the Online
Backup Client, you can choose to back up the data from all of them. It is required to enter the user
credentials per instance.
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14.2 Backup
When a connection to the SQL Server is established, the ‘MS SQL Server’ icon will be visible in the Folder
pane of the ‘Data’ tab in the Task Properties. The databases are child-nodes.
Select databases to add them to the backup task, so they will be backed without any further user
intervention.
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14.2.1 Backup requirements


A connection to the SQL Server is created using Integrated Security or by a user provided
username/password combination. In any case the Online Backup Client must be provided with
sufficient rights to perform the SQL backup procedures. 



In order to create a backup of a database, the user that connects to the SQL Server must be
assigned the sysadmin Server Role and the db_backupoperator and dbo_owner DB roles. 



14.2.2 Further notes on backup procedures


The Online Backup Client connects to the local MS SQL Server so only backups of local databases
can be performed. 



The tempdb database cannot be backed up or restored. Do not select this database for backup. 



The Online Backup Client can perform 'full' and 'differential' backups on MSSQL Server. The
backup method that will be used is chosen automatically. 





14.3 Restore
Databases that are available for restore can be found in the ‘MS SQL Server’ folder in the ‘Restore’ view.
This folder contains the ‘SQL Server’ folder, which contains the backed up databases. These databases
can be selected for restore.

When the restore procedure is started you are asked for a destination folder of the database files.
Please note that this location will be the location where MS SQL Server will mount the restored
database. The default location that is used by MS SQL Server to store database files is C:\Program
Files\Microsoft SQL Server\MSSQL\Data.
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The Online Backup Client will try and download the database that is to be restored and insert it into the
local instance of MS SQL Server. If a database with the same name already exists on the computer, it will
be overwritten. You can choose to create a copy or to overwrite the original database.

Caution: NEVER overwrite a database that is in production
14.3.1 Restore requirements
The Online Backup Client must be provided with correct permissions to perform the restore operation.
According to Microsoft the user that connects to the Server must have the sysadmin and dbcreator
Server roles and db_owner DB role assigned to it. More information:
http://msdn.microsoft.com/en-us/library/ms187048.aspx
A restore of the master database can only be performed when the Server is in single user mode. SQL
Server can be started in single user mode from the command line using the -m command line option:

"\Program Files\Microsoft SQL Server\MSSQL\Binn\sqlservr" -m.
Note: The Online Backup Client connects to the local MS SQL Server so only restores into the local
computer can be performed.

15. Hyper-V
15.1 Introduction
Hyper-V is a native hypervisor that enables platform virtualization on x86-64 systems. Through a plugin
in the client it is possible to backup and recover virtual machines. This plugin is enabled by default. To be
able to backup and restore a Hyper-V virtual machines, make sure the client is installed on a machine
that runs the Hyper-V environment.
15.2 Hyper-V Backup
To make a backup of a Hyper-V environment it is simply a matter of choosing the virtual machine(s)
you want to backup through the Data view.
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15.3 Hyper-V Restore
To restore the Hyper-V environment you choose the Hyper-V virtual machine or hard disk you want to
restore in the restore screen. Select the latest or a specific version in order to restore it to the original
location. During restore the current Hyper-V virtual machine will be unavailable until the restore has
finished mounting the image.
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Online Backup Client User Manual Mac OS 5.0
1. Product Information
Product: Online Backup Client for Mac OS X
Version: 5.0.1
1.1 System Requirements

Operating System

Hardware Resources

Required software



Mac OS X Leopard (10.5.0 and higher) (PPC is not supported, Intel
only)



Mac OS X Snow Leopard (10.6.0 and higher)



Mac OS X Lion



Mac OS X Mountain Lion



1 GB memory



25 MB of disk space



Internet connection (e.g. ADSL, SDSL)



Java 1.6 platform or higher is required

Note: A separate manual is available for the Online Backup Client for Microsoft Windows and Linux.
Note: There are two types of accounts: Workstation and Server. In case of a Mac OS X Server, a Server
license is required to activate the client software.

2. Features
The Online Backup Client has several features. It supports different kinds of data. It can backup normal
data but also specific data.


You can make one or more scheduled tasks to backup data automatically (e.g. daily, weekly).



The Online Backup Client fully supports all Mac file formats, including user rights.

The Online Backup Service also includes a Management Console, which can be accessed through an
Internet browser (e.g. Safari). It has several functions:


Change user settings (e.g. password)



Overview of your backups through logs and reports

3. Setup
3.1 Setup Wizard
The installation file has a size of 6,79 MB. The installation file of the Online Backup Client is a ‘DMG’-file,
which will introduce a friendly installation program. The language of the installation program is
automatically chosen and is the same as your system language.
1

Note: After the installation program, you can adjust the language of the Online Backup Client.

Now you can:


Read the release notes



Accept the license agreement

2



Choose the destination volume for installation

3

The installation program will ask for the login credentials of the administrator of the system.

The Online Backup Client is successfully installed on your computer.
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3.2 Registration Wizard
When you start up the Online Backup Client for the first time, it will start with the Registration Wizard.
The Registration Wizard guides you to enter the account information and encryption key. With the
encryption key your data will be encrypted and decrypted.

You need to fill in the username and password that you created or obtained from your Online Backup
Provider.
Note: You also have to enter a Computer name. This name will be registered at the Backup Server
storage location to store all files.
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Note: If you don’t remember your password you can click on the link below the password text field. A
reminder will then be sent to your registered e-mail address.
Note: If there is a problem with the username and password, the Online Backup Client will show a
prompt that signing in is not possible. Several causes can apply to this:


The username and/or password does not exist or is incorrect



The time on the client machine differs very much from the real time (more than 24 hours)



The Online Backup Client cannot access the online services while port 443 (SSL) is blocked by a
firewall on the network

The next wizard page will ask you to set an encryption key. The purpose of this key is to encrypt all files
before transferring them to the Backup Server and decrypt the files from the Backup Server when
restoring them.
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You must type an encryption key and then confirm this key. You can only set the encryption key once.
After setting the encryption key it cannot be changed. If you forget the encryption key, the data
encrypted with this key cannot be accessed anymore. Please write down the encryption key in a safe
place.
IMPORTANT: This key is unique and can only be chosen once and cannot be changed afterwards. Treat
this key with great care, since it is required to restore your files after a system crash.
Note: It is possible to store a reminder which can be sent to your personal e-mail address. In this wizard
the field to enter the reminder will change into a link: ‘Forgot your encryption key?’

The wizard is now finished.
Note: You can access the registration wizard again if needed by clicking on the head icon in the lower
left of the main screen below 'Account Information'.
4. Online Backup Client main interface
This is the main interface of the Online Backup Client. Several components are displayed in the figure
below:


Menu



Account Information



Main panel (e.g. Home)
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Menu
The menu is the main navigation through the Online Backup Client. The options:


Home: Start View



Backup: Select local data for a backup



Restore: Select remote data for a restore



Reports and Logs: View information on executed backups and restores



Options: Configure backup tasks



Support: View contact information for support



About: Additional information about the Online Backup Client

Account Information
Shows account details: account name, storage space, status and usage of storage space.
Main Panel
The main panel is the working space of the Online Backup Client. Depending on what you want to do,
this panel will show the necessary views.
4.1 Home
When you start the Online Backup Client it will show the Online Backup Client Home view. This view
shows the status of the last and the next backup task.
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4.2 Backup
You can backup data by clicking on “Backup” in the Menu panel.

4.2.1 Create or change a backup task
Create task


Here you can make a choice between an online backup or an offline backup



Click on ‘New Task’ to create a new backup task.



The Task Properties will open, and you can configure:


General



Data



Schedule



Filter
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MySQL



Advanced

Note: The offline backup is currently not available when setting the language to English. This is due to a
patent issue. As a workaround the client can be set temporarily to a different language in order to be
able to create an offline backup. If you specifically need this option in the English language, please
contact the support department for instructions.
Change task


Select the task in the tree view, and click on ‘Edit Task’.



The Task Properties will open, and you can configure:


General



Data



Schedule



Filter



MySQL



Advanced

4.2.2 General
The ‘General-tab’ gives you a summary of the backup task. You can change the name of the backup task
in this screen and choose between the type of backup: online or offline (local backup). More information
about offline backup can be found in chapter 4.3.

Task Name
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You can give the backup task a name.
Set Retention
Retention allows you to set the number of days your backup data will be kept before it is removed. Data
will be removed after set number of days in the following situations:


If an existing full backup is replaced by a new full backup
Example: A full backup takes place when data is backed up for the first time, or when the
difference in data is more than 50%. If a new full backup is made, the old full backup will be
automatically removed after the set number of days.



If the task is no longer active for that period of time
Example: If you set retention to 7 days and stop the OnlineBackupService or shut down your
computer for that period of time, the backup data will be automatically removed. The retention
time will only become active the second time you run the backup task.



If the data is no longer located at the original location
Example: If you made a backup of certain folder and you remove, rename or replace that folder
on your computer, the backup of the folder will be deleted after set number of days.

You can also choose to not remove the selected backup data, in which case all backups of the data will
be kept.
If you want to change the retention value of the current files on the storage and the current value is
higher than what you want to set it to, you need to change the retention via the ‘reset retention’ option
in the restore view (see chapter 4.4.6). Remember that a retention value of zero days (permanent)
counts as the highest value.
Note: When the task is set as an offline backup type (local backup), the option to set retention will be
greyed out.
Note: The retention value is changed for all files in the task, no matter whether they still exist on the
user’s computer or not.
Backup Type
Choose 'Online Backup' to make a backup to the cloud.
4.2.3 Data
You can select data to backup in the ‘Data’ tab in the Task properties. You can easily expand and
collapse the branches of the tree, by clicking the pointers displayed at the left. All items are displayed
with their type.
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When a folder is selected for backup, underlying files and folders are automatically part of the selection,
unless explicitly deselected.
Note: If a folder is checked with a grey background only a subset of this folder is part of the backup set.
Note: A light grey square in front of a file or folder means that it is not possible to adopt that item in the
backup set.
4.2.5 Schedule
You can set a schedule for the backup task in the ‘Schedule-tab’ in the Task properties.
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The following schedule options are possible:


Never Performs a backup only when you start it manually



Once: Performs a backup once on the time that is inserted



Daily: Performs a backup daily on the time that is inserted



Weekly: Use this option to select which time and day(s) the backup must be performed



Monthly: Use this option to select which part of the month and day of the week the backup
must be performed

By checking ‘Active’, the backup task will be performed automatically on the scheduled times.
4.2.6 Filter
You can add file filters or folder filters that are excluded or included in the backup task. You can also
choose to include hidden files by checking the checkbox.
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The various filter options are:


No file filtering (default)



Filter out files on file name/extension (‘Except specific files’)



Filter out all files except with a certain file name/extension (‘Exclude all but specific files’)



Filter out folders by path pattern (e.g. Temp, Cookies, etc).

4.2.7 MySQL
Instead of a file backup you can select to make a MySQL backup.
Open the MySQL tab and in case you have already activated the MySQL plugin in Options, you can see
the MySQL backup plugin with the available servers and databases. Here you can select a database or
even a table for the backup.
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4.2.8 Advanced
Pre-Script
A Pre-Script is an advanced option to run certain operations before starting the backup task. You can
simply browse a command or shell script which will be executed prior to the start of the backup task.
Continue processing if pre-script fails
When checked, the backup will be performed, even if the pre-script did not run properly.
Post-Script
A Post-Script is an advanced option to run certain operations after a backup task has run. You can simply
browse a command or shell script which will be executed after the backup task is completed.
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4.2.9 Backup progress
The backup process can be monitored by clicking on the magnifier icon on the lower left of the menu
screen during the process of a backup.

The details regarding the backup of data:
Progress information


File progress: The progress of the backup of the indicated file



Total progress: The progress of the total backup task

In the table (the amount of files, the amount of selected MBs and the amount of sent MBs)


Full: Full backed up files
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Patch: Patched backed up files (incremental backups)



NoNeed: Unchanged files (unchanged compared to last backup)



Skipped: Skipped files (details in the logs (explained later))



Done: The total amount of processed data



Total: The total amount of selected data



%Done: The percentage of processed data

Other information


Proc.speed (Upl.speed): The average upload speed



Compression: The average compression rate of the backed up data



Remaining time: The estimated remaining time



Size uploaded: The size of the uploaded data



Elapsed time: The elapsed time



Total size: The total size of the selected data

4.3 Offline backup
You can create an offline backup task by selecting 'Offline backup (local backup)' in the General section
of a backup task.

This is intended for the seed backup for a customer. This creates a .zip file which can be moved to the
backup server and extracted there for the initial backup.
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Note: The offline backup is currently not available when setting the language to English. This is due to a
patent issue. As a workaround the client can be set temporarily to a different language in order to be
able to create an offline backup.
Task Name
You can give the backup task a name.
Set Retention
Retention allows you to set the number of days your backup data will be kept before it is removed. Data
will be removed after set number of days in the following situations:


If an existing full backup is replaced by a new full backup
Example: A full backup takes place when data is backed up for the first time, or when the
difference in data is more than 50%. If a new full backup is made, the old full backup will be
automatically removed after the set number of days.



If the task is no longer active for that period of time
Example: If you set retention to 7 days and stop the OnlineBackupService or shut down your
computer for that period of time, the backup data will be automatically removed. The retention
time will only become active the second time you run the backup task.



If the data is no longer located at the original location
Example: If you made a backup of certain folder and you remove, rename or replace that folder
on your computer, the backup of the folder will be deleted after set number of days.

You can also choose to not remove the selected backup data, in which case all backups of the data will
be kept.
Note: When the task is set as an offline backup type (local backup), the option to set retention will be
greyed out.
Note: The retention value is changed for all files in the task, no matter whether they still exist on the
user’s computer or not.
Backup type
Set the backup type to ‘Offline backup’ and click on ‘Browse’ to select the storage location.
Here you can also decide whether to create a Zip archive or not.
A zip archive is smaller to save, but you do have to unzip the files on the backup server when this is an
initial offline backup.
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All the next steps are the same as for an Online backup.
4.4 Restore
Your backed up data can be accessed by clicking “Restore” in the Menu panel.
4.4.1 View backed up data
The view shows a collection of computers in the tree view. These computers are the base of the backup
schedules. If the Online Backup Client is (or was previously) installed on a computer, this computer will
be shown in this screen. Furthermore, the tree view shows all backed up data in the same structure as it
was on your computer. In this view you can restore as well as delete data from the Backup Server.

4.4.2 Restore latest versions of data
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Data can be restored per file, folder or drive. Select files, folders or drives you want to restore, in the
node tree. By clicking the 'Restore’ button, the latest version will be restored automatically.
This is the most common option.

Before the restore starts, the client will ask you where you want to store the restored data. You can
choose between the Default Location, the Original Location or a Selected Location.
Note: If a file already exists on the restore location, a prompt appears that allows you to skip, rename or
overwrite the file.
4.4.3 Restore older versions of data
When a file has been changed within the period between two backups, the client will back up the file
and notice that it is changed. The Online Backup Client will than create multiple versions of the file on
the Backup Server (only if you have selected to store multiple versions, see later in this manual).
Restore at date
It is possible to restore a file or folder at a selected date in history. You select a file or folder in the
‘Restore’ view and click on ‘Restore’ in the lower main panel. In the ‘Restore’ view that appears, click on
the ‘Versions before date’ button. Here you can select a date in history. The latest backed up versions of
the selected files or folder before that date will be restored.
4.4.4 Restore process
The restore process can be monitored by clicking on the magnifier icon on the lower left of the menu
screen during the process of a restore.
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The details regarding the restore of data:
Progress information


Status: the status of the restore



Processing resource: The progress of the restore of the indicated file



File progress: The progress of the restore of the indicated file



Proc.speed (Upl.speed): The download speed in KB/s



Compression: The compression of the files downloaded



Elapsed time: The amount of time the restore has been running so far



Size downloaded: The size of the restored files

4.4.5 Deleting data from Backup Server
To delete data from the Backup Server, click on "Restore" in the Menu panel. Select the data that needs
to be deleted by checking the check-boxes (you can select multiple files or folders). Click on the "Delete"
button in the lower main panel to delete the file(s). The client will ask you to confirm the delete action.

Note: You can choose to delete all data except the latest versions. This can be useful to clean up your
backup account.
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4.4.6 Reset Retention
Within the Restore view it is also possible to reset the retention per file, per folder or per computer on
the storage. Click on the 'More' button in the lower right corner to set the retention. Note that resetting
retention will count for all subfolders, files and versions within those folders.
4.5 Options
You can set different kind of settings by clicking “Options” in the Menu panel.

4.5.1 General
In the “General”-tab, you can set general options of the Online Backup Client:


You can change the language of the application



You can able or disable the sending of backup and restore reports by e-mail



You can able or disable to always install an update when it is available



You can see your Username and change the password of your backup account

Note: It might not be possible to change your password in the Online Backup client, since your Online
Backup Provider can disable this option
Note: It is not possible to change the username or encryption key.
4.5.2 Backup and Restore
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In the “Backup and Restore”-tab, you can set options that are specific for backing up and restoring with
the Online Backup Client:

Data Retention
In this view you can set the default data retention value. By default this is 30 days. This default value will
be used when creating new backup tasks.
Restoring
In this view the default restore folder can be specified. This is the folder where data is restored by
default when you don’t choose a specified folder
Restoring
You can enable or disable to always calculate the restore size.
4.5.3 Advanced
In the “Advanced”-tab, you can set advanced options of the Online Backup Client:
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Advanced: You can set the type of encryption of the data that will be backed up: AES 128 bits or
256 bits encryption.



Connection: You can set the time-out for the service requests.



Logging: You can set the directory where you can save the log files.You can also enable ‘Detailed
logging’ for troubleshooting. Normally you only enable this when support asks you to do so.

4.5.4 Plugins
In the “Plugins-tab”, you can set the options for all available plugins.
4.6 MySQL backup
Within the “Plugins-tab” you can activate the MySQL backup plugin. Once you have this activated you
can set the plugin options like the URL, username and password.
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4.7 Report details
Click on “Reports and Logs” in the Menu panel for a chronological overview of important events.
4.7.1 Reports
The “Reports”-view shows a history of reports. You can view the status of the past backups and restores:
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Double-clicking on a report will show report details.

This report will also be sent to you be e-mail.
It is possible to clean the reports or logs list. In the list of reports or logs, click on the button ‘Delete
selection’.
4.7.2 Logs
The ‘Logs’ view shows a history of log files.
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Three types of events can occur:


Information: Information regarding the progress of the backup or restore procedure.



Warning: Non-fatal errors occurred during backup or restore process.



Error: A fatal error has occurred in the Online Backup Client.

Details of the log message can be viewed by clicking on [View]. This shows a dialogue with detailed
information of the message.

4.8 Support
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Clicking on “Support” in the Menu panel will give contact details of your Online Backup Provider.

4.9 About
Clicking on “About” in the Menu panel will give details on the version of the software and the license of
the software.
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5. Uninstalling Online Backup Client
Normally applications can be removed by dragging the icon into the recycle bin. Because the Online
Backup Client runs as a service component, this cannot be done. You can drag the icon to the recycle
bin, but then the service part remains and must be removed manually afterwards.
The correct way to uninstall the Online Backup Client is to run the uninstall.sh from the application
directory (Applications/’Client name’/Contents/Resources) through the terminal. First change to the
mentioned directory and then run the following command:
sudo ./uninstall.sh
If this script doesn't exist anymore (because the user has dragged the icon to the recycle bin and
emptied it), you need to manually remove the service part.
First try to remove by running the uninstall.sh from the application directory.
When this is not possible, follow the instructions below:
1. Log in as a user with administrative rights
2. Start terminal.app (via Applications->Utilities->Terminal)
In the new terminal window, apply the following commands:
1. sudo launchctl stop com.backupagent.agent
2. sudo launchctl unload /Library/LaunchDeamons/com.backupagent.agent.plist
3. sudo rm /Library/LaunchDaemons/com.backupagent.agent.plist
Enter your password when required.
1. Next, remove the installation package. This makes sure that the next installation performs a full
installation and not an update. You need to know the name of the installation package. If the
name is "OnlineBackupClient Installer.pkg" then the following command should be run: sudo rm
-fr "/Library/Receipts/OnlineBackupClient Installer.pkg"
2. Remove the startup item (on Tiger OS only):


Open system preference



Navigate to users



Select your name



Select Startup Items



Delete the entry for the Online Backup Client
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Online Backup Client User Manual Linux 5.0.1
1. Product Information
Product: Online Backup Client for Linux
Version: 5.0.1
1.1 System Requirements

Operating System

Hardware Resources

Required software



Linux, all distributions with Java 7, 32 bit & 64 bit



Solaris 10



Solaris 11



PC with 1 gigahertz (GHz) or higher processor clock speed
recommended



1,5 GB memory



25 MB of disk space



Internet connection (e.g. ADSL, SDSL)



Java 1.6 platform or higher is required

Note: A separate manual is available for the Online Backup Client for Microsoft Windows and Mac OS X.
Note: There are two types of accounts: Workstation and Server. Only the Server account is available for
use with the Linux client.

2. Features
The Online Backup Client has several features. It supports different kinds of data. It can backup normal
data but also specific data.


You can make one or more scheduled tasks to backup data automatically (e.g. daily, weekly).



The Online Backup Client fully supports all Linux file formats and user rights.

The Online Backup Service also includes a Management Console, which can be accessed through an
Internet browser. It has several functions:


Change user settings (e.g. password).



Overview of your backups through logs and reports.

3. Setup
3.1 Software installation
Currently there is no package available for Linux. Setup of the Online Backup Client is performed using
the following instructions:
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Copy the Online Backup Client archive ([your-setup-name].tar.gz) to your system and place it in
your $HOME directory.



create a new directory:

mkdir $HOME/OnlineBackupClient


change to this directory and extract the archive:

cd $HOME/OnlineBackupClient
tar xzf $HOME/[your-setup-name].tar.gz


This will create the two following folders:

Server/

This folder contains the Online Backup Service component.

Client/

This folder contains the user-interface application for the Online Backup Client.

CommandLine This folder contains the CommandLine client part of the Backup Client.


Start the Online Backup Service:

cd $HOME/OnlineBackupClient/Server
./server-with-logging.sh
This will start the Online Backup Client Service and place it in the background.
Here you will be asked to enter your (sudo) password, so the Online Backup Client can access all the
files.


Start the Online Backup Client User Interface:

cd $HOME/OnlineBackupClient/Client
./client-with-logging.sh
This will start the Online Backup Client User Interface and, if this is a first-time installation, present you
with the Registration Wizard.
Note: After the setup, you can adjust the language of the Online Backup Client.
3.2 Registration Wizard
When the Online Backup Client is started for the first time, it will start with the Registration Wizard. The
Registration Wizard guides you to fill in the account information and encryption key. With the
encryption key your data will be encrypted and decrypted.
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You need to fill in the address of the Backup Server to connect to; your Online Backup Provider will
provide you with this address. You can test the address by clicking on ‘Test’.

You need to fill in the username and password that you created or obtained from your Online Backup
Provider.
Note: You also have to fill in a Computer name. This which will be registered at the Backup Server to
store all files.
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Note: If you do not remember your password you can click on the link below the Username text field. A
reminder will then be sent to your registered email address.
Note: If there is a problem with the username and password, the Online Backup Client will show a
prompt that signing in is not possible. There can be several reasons for this to occur:


The username and/or password does not exist or is incorrect.



The time on the client machine differs too much from the real time (more than 24 hours).



The Online Backup Client cannot access the online services while port 443 (SSL) is blocked by a
firewall on the network.

The next wizard page will ask you to set an encryption key. The purpose of this key is to encrypt all files
before transferring them to the Backup Server and decrypt the files from the Backup Server when
restoring them.
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You must type an encryption key and then confirm this key. You can only set the encryption key once.
After setting the encryption key it cannot be changed. If you forget the encryption key, the data
encrypted with this key cannot be accessed anymore. Please write down the encryption key in a safe
place.
IMPORTANT: This key is unique and can only be chosen once and cannot be changed afterwards. Treat
this key with great care, since it is required to restore your files after a system crash.
Note: It is possible to store a reminder which can be sent to your personal email address. In this wizard
the field to enter the reminder will change into a link: ‘Forgot your encryption key?’
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The wizard is now finished.
Note: You can access the registration wizard again if needed by clicking on the head icon in the lower
left of the main screen below 'Account Information'.

4. Online Backup Client main interface
This is the main interface of the Online Backup Client. Several components are displayed in the figure
below:


Menu



Account Information



Main panel (e.g. Home)

Menu
The Menu is the main navigation through the Online Backup Client. The options are:


Home: Start View



Backup: Select local data for a backup



Restore: Select remote data for a restore



Reports and Logs: View information on executed backups
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Options: Configure backup tasks



Support: View contact information for support



About: Additional information about the Online Backup Client

Account Information
Shows account details: account name, storage space, status and usage of storage space.
Main Panel
The main panel is the working space of the Online Backup Client. Depending on what you want to do,
this panel will show the necessary views.
4.1 Home
When you start the Online Backup Client it will show the Online Backup Client Home view. This view
shows the status of the last and the next backup task.

4.2 Online backup
You can create an online backup task by clicking on “Backup” in the Menu.
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4.2.1 Create or change backup task
To create or change a backup task:
Create task


Click on ‘New Task’ to create a new backup task.



The Task Properties will open, and you can configure:


General (change name of backup task)



Data



Schedule



Filter



MySQL



Advanced

Change task


Select the task in the tree view, and click on ‘Edit Task’.



The Task Properties will open, and you can configure:


General (change name of backup task)



Data



Schedule
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Filter



MySQL



Advanced

4.2.2 General
The ‘General’ tab gives you a summary of the backup task. You can change the name of the backup task
in this screen.
This is also the place where you can decide between an online backup and an offline backup. More
information about offline backup can be found in chapter 4.3.

Task Name
You can give the backup task a name.
Set Retention
Retention allows you to set the number of days your backup data will be kept before it is removed. Data
will be removed after set number of days in the following situations:


If an existing full backup is replaced by a new full backup
Example: A full backup takes place when data is backed up for the first time, or when the
difference in data is more than 50%. If a new full backup is made, the old full backup will be
automatically removed after the set number of days.



If the task is no longer active for that period of time
Example: If you set retention to 7 days and stop the OnlineBackupService or shut down your
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computer for that period of time, the backup data will be automatically removed. The retention
time will only become active the second time you run the backup task.


If the data is no longer located at the original location
Example: If you made a backup of certain folder and you remove, rename or replace that folder
on your computer, the backup of the folder will be deleted after set number of days.

You can also choose to not remove the selected backup data, in which case all backups of the data will
be kept.
Note: When the task is set as an offline backup type (local backup), the option to set retention will be
greyed out.
Note: The retention value is changed for all files in the task, no matter whether they still exist on the
user’s computer or not.
Backup Type
Choose 'Online Backup' to make a backup to the cloud.
4.2.3 Data
You can select data to backup in the ‘Data’ tab in the Task properties. You can easily expand and
collapse the branches of the tree, by clicking the pointers displayed at the left. All items are displayed
with their type.
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When a folder is selected for backup, underlying files and folders are automatically part of the selection,
unless explicitly deselected.
Note: If a folder is checked with a grey background only a subset of this folder is part of the backup set.
Note: A light grey square in front of a file or folder means that it is not possible to adopt that item in the
backup set.

4.2.4 Schedule
You can set a schedule for the backup task in the ‘Schedule tab’ in the Task properties.

The following schedule options are possible:


Never: Performs a backup only if you manually start the task.



Once: Performs a backup once at the time that is inserted.



Daily: Performs a backup daily at the time that is inserted.



Weekly: Use this option to select which time and day(s) the backup must be performed.



Monthly: Use this option to select which part of the month and day of the week the backup
must be performed.

By checking ‘Active’, the backup task will be performed automatically on the scheduled times.
Note: If you select a task in the view “Backup”, and click on ‘Start task’, the backup task will be
performed immediately.
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4.2.5 Filter
You can add file filters or folder filters that are excluded or included in the backup task. You can also
choose to include hidden files by checking the checkbox.

The various filter options are:


No file filtering (default)



Filter out files on file name/extension (‘Except specific files’)



Filter out all files except with certain file name/extension (‘Exclude all but specific files’)



Filter out folders by path pattern (e.g. Temp, Cookies, etc).

4.2.6 MySQL
Instead of a file backup you can select to make a MySQL backup.
Open the ‘MySQL-tab’ and you can see the MySQL backup plugin with the available servers and
databases. Here you can select a database or even a table for the backup.
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4.2.7 Advanced
Pre-Script
A Pre-Script is an advanced option to run certain operations before starting the backup task. You can
simply browse to a command or shell scripts (e.g. /home/script.sh) which will be executed prior to the
start of the backup task.
Continue if Pre-Script fails
When checked, the backup will be performed, even if the pre-script did not run properly.
Post-Script
A Post-Script is an advanced option to run certain operations after a backup task has run. You can simply
browse to a command or shell script (e.g. /home/script.sh) which will be executed after the backup task
is completed.
User
This field indicates the user that is used to execute the script.
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4.2.9 Backup progress
The backup process can be monitored by clicking on ‘Details’ at the bottom of the application during the
process of a backup (the details screen will pop up automatically when a backup task is initiated).

The details regarding the backup of data are:
Progress information


File progress: The progress of the backup of the indicated file
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Total progress: The progress of the total backup task

In the table (the amount of files, the amount of selected MBs and the amount of sent MBs)


Full: Fully backed up files, which have not been backed up before



Patch: Patched backed up files (incremental backups)



NoNeed: Unchanged files (unchanged compared to the last backup)



Skipped: Skipped files (details in the logs (explained later))



Done: The total amount of processed data



Total: The total amount of selected data



%Done: The percentage of processed data

Other information


Proc.speed (Upl.speed): The average upload speed



Compression: The average compression rate of the backed up data



Remaining time: The estimated remaining time



Size uploaded: The size of the uploaded data



Elapsed time: The elapsed time



Total size: The total size of the selected data

4.3 Offline backup
You can create an offline backup task by clicking on ‘Backup’ in the ‘Navigation’ panel.
This is intended for the seed backup for a customer. This creates a .zip file which can be moved to the
backup server and extracted there for the initial backup.
Note: The offline backup is currently not available when setting the language to English. This is due to a
patent issue. As a workaround the client can be set temporarily to a different language in order to be
able to create an offline backup.
Task Name
You can give the backup task a name.
Set Retention
Retention allows you to set the number of days your backup data will be kept before it is removed. Data
will be removed after set number of days in the following situations:


If an existing full backup is replaced by a new full backup
Example: A full backup takes place when data is backed up for the first time, or when the
difference in data is more than 50%. If a new full backup is made, the old full backup will be
automatically removed after the set number of days.



If the task is no longer active for that period of time
Example: If you set retention to 7 days and stop the OnlineBackupService or shut down your
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computer for that period of time, the backup data will be automatically removed. The retention
time will only become active the second time you run the backup task.


If the data is no longer located at the original location
Example: If you made a backup of certain folder and you remove, rename or replace that folder
on your computer, the backup of the folder will be deleted after set number of days.

You can also choose to not remove the selected backup data, in which case all backups of the data will
be kept.
Note: When the task is set as an offline backup type (local backup), the option to set retention will be
greyed out.
Note: The retention value is changed for all files in the task, no matter whether they still exist on the
user’s computer or not.
Backup type
Set the backup type to ‘Offline backup’ and click on ‘Browse’ to select the storage location.
Here you can also decide whether to create a Zip archive or not.
A zip archive is smaller to save, but you do have to unzip the files on the backup server when this is an
initial offline backup.
All the next steps are the same as for an Online backup.
4.4 Restore
Your backed up data can be accessed by clicking “Restore” in the Menu panel.
4.4.1 View backed up data
This view shows a collection of computers in the tree view. These computers are the base of the backup
schedules. If the Online Backup Client is (or was previously) installed on a computer, this computer will
be shown in this screen. Furthermore, the tree view shows all backed up data in the same structure as it
was on your computer. In this view you can restore or delete data from the Backup Server. You are also
able to import a local backup for restore.
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4.4.2 Restore latest versions of data
Data can be restored per file, folder or drive. Select files, folders or drives you want to restore, in the
node tree. By clicking the 'Restore’ button, the latest version of the data will be restored automatically.
This is the most common option.

17

Before the restore starts, the client will ask you where you want to store the restored data. You can
choose between the Default Location, the Original Location or an Alternative Location.
Note: If a file already exists on the restore location, a prompt appears that allows you to skip, rename or
overwrite the file.
4.4.3 Restoring older versions of data
When a file has been changed within the period between two backups, the client will backup the file
and notice that it has changed. The Online Backup Client will then create multiple versions of the file
depending on the retention value you set.
Restore at date
It is possible to restore a file or folder from a selected date in the past. You select a file or folder in the
‘Restore’ view and click on ‘Restore’ in the lower main panel. In the ‘Restore’ view that appears, click on
the ‘Versions before date’ button. Here you can select a date. The latest backed up versions of the
selected files or folder before that date will be restored.
4.4.4 Restore process
The restore process can be monitored by clicking on ‘Details’ on the bottom of the application during
the process of a restore (the details screen will pop-up automatically when a restore is initiated).

The details regarding the restore of data:
Progress information


Status: The status of the restore



Processing resource: The file that is being restored at the time



File progress: The progress of the restore of the indicated file



Proc.speed (Upl.speed): The download speed in KB/s



Compression: The average compression rate of the backed up data



Elapsed time: The amount of time the restore has been running so far



Size downloaded: The size of the downloaded data
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4.4.5 Deleting data from Backup Server
To delete data from the Backup Server, click on "Restore" in the Menu panel. Select the data that needs
to be deleted by checking the checkboxes (you can select multiple files or folders). Click on the "Delete"
button in the lower main panel to delete the file(s). The client will ask you to confirm the delete action.

Note: You can choose to delete all data except the latest versions. This can be useful to clean up your
backup account.
4.4.6 Reset Retention
Within the Restore view it is also possible to reset the retention per file, per folder or per computer on
the storage. Click on the 'More' button in the lower right corner to set the retention. Note that resetting
retention will count for all subfolders, files and versions within those folders.
4.5 Options
You can set different kinds of settings by clicking “Options” in the Menu panel.
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4.5.1 General
In the “General”-tab, you can set general options of the Online Backup Client:


You can change the language of the application



You can enable or disable the sending of backup and restore reports by email



You can enable or disable to always install an update when it is available



You can see your username and change the password of your backup account

Note: It might not be possible to change your password in the Online Backup Client, since your Online
Backup Provider can disable this option
Note: It is not possible to change the username or encryption key.
4.5.2 Backup and Restore
In the “Backup and Restore”-tab, you can set options that are specific for backing up and restoring with
the Online Backup Client:
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Data Retention
In this view you can set the default data retention value. By default this is 30 days. This default value will
be used when creating new backup tasks.
Restoring
In this view the default restore folder can be specified. This is the folder where data is restored by
default when you don’t choose a specified folder.
You can enable or disable to always calculate the restore size.
4.5.3 Advanced
In the “Advanced” tab, you can set advanced options of the Online Backup Client:
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Advanced: You can set the type of encryption of the data that will be backed up: AES 128 bits or
256 bits encryption.



Connection: You can set the time-out for the service requests.



Logging: You can set the directory where you can save the log files.You can also enable ‘Detailed
logging’ for troubleshooting. Normally you only enable this when support asks you to do so.

4.5.4 Plugins
In the “Plugins” tab, you can set the options for all available plugins.
4.6 MySQL backup
Within the “Plugins” tab you can activate the MySQL backup plugin. Once you have this activated you
can set the plugin options like the URL, username and password. This plugin can be used to backup local
or remote MySQL databases.
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4.7 Report details
Click on “Reports and Logs” in the Menu panel for a chronological overview of important events.
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4.7.1 Reports
The “Reports” view shows a history of reports. You can view the status of past backups and restores:

Double-clicking on a report will show report details:

This report will also be sent to you by email.
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It is possible to clean the reports or logs list. In the list of reports or logs, click on the ‘Delete selection’
button.
4.7.2 Logs
The ‘Logs’ view shows a history of log files:

Three types of events can occur:


Information: Information on the progress of the backup or restore procedure.



Warning: Non fatal errors occurred during backup or restore process.



Error: A fatal error has occurred in the Online Backup Client.

Details of the log message can be viewed by clicking on ‘View’. This shows a dialogue with detailed
information of the message.
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4.8 Support
Clicking on “Support” in the Menu panel will give contact details of your Online Backup Provider.

4.9 About
Clicking on “About” in the Menu panel will give details about the version of the software and the license
of the software.
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